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Copyright ©2014-2022 Burk Technology, Inc. All rights reserved. 

Information in this manual is subject to change without notice 

Thank you for purchasing an ARC Solo Remote 

Control.  You can expect state of the art 

convenience and reliability that will provide years 

of satisfaction. 

We’ve observed that installations go smoothly 

when the engineer plans the project and allows 

time for familiarization before jumping in.   

We recommend setting up new units in a 

comfortable work environment before installing at 

the transmitter site. In addition to hardware 

familiarization, it will also be possible to do much 

of the configuration before going to the site. 

 



 

3 

 

USING THIS MANUAL 

This manual is best viewed as a .pdf on a computer or 

tablet, as there are many hypertext links to help you get to 

the section you need. Since most of the initial setup 

requires a web browser, keeping a copy of the manual in 

.pdf form on the same machine is very natural.  

The .pdf file has bookmarks to help with navigation, so be 

sure you have a current copy of Adobe Reader on your 

computer and have the Bookmarks enabled. You can 

download the most recent version at 

http://get.adobe.com/reader/. 

To enable bookmarks, press     and expand the desired 

section by pressing . 

You can also jump directly to a section from TABLE OF 

CONTENTS . Just click on the section or page number to go 

directly there. 

Please take a few minutes to familiarize yourself with the 

organization of this manual, as it will likely save time later 

when you need to find a specific piece of information quickly. Throughout the manual, you will find 

hypertext links that look like this: USING THIS MANUAL. Click on the link to go directly to the named 

section. 

For starters, here is a quick set of links to the major sections of the manual: 

USING THIS MANUAL This section 

TABLE OF CONTENTS  Fully expanded table of contents useable in .pdf or printed form 

INTRODUCTION Brief overview of the ARC Solo 

OPERATION 
Touch screen menu system, web pages and RSI in sufficient detail for 
operators to be able to use the system effectively 

Error! Reference source not f
ound. 

Hardware installation and input/output connections 

CONFIGURING THE RSI Configuration setup required for the RSI (recordable speech interface) 

 
METERS 

Web configuration for analog meter inputs 

STATUS Web configuration for status inputs 

COMMANDS Web configuration for relay operation 

CONFIGURING JET EMAIL 
TEMPLATES (MACROS) 

Web configuration on how to set up Jet email template (macros)  

Error! Reference source not f
ound. 

ARC Solo specifications 

APPENDIX B: RSI VOCABULARY RSI vocabulary 

  

http://get.adobe.com/reader/
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INTRODUCTION 

The ARC Solo includes many of the powerful features of the ARC Plus while offering the simplicity of a self-

contained remote control unit. Sixteen meter and status inputs and sixteen relays are directly available on the rear 

apron. Operators can access the site from anywhere by PC or smartphone using the built-in web server or as part 

of a group of stations using AutoPilot®. Telephone control is also included as standard. Jet Active Flowcharts, email 

notifications and even the new RSI Recordable Speech Interface are built in. 

INSTALLATION  

The suggested sequence for installation is to perform a complete setup at the bench then install the equipment at 

the transmitter site, connect I/O and calibrate. 

NEEDED ITEMS 

• ARC Solo Remote Control Unit 

• Current web browser 

• AutoLoad Plus software, revision 3.1.83 or higher, for speech editing only; 

downloaded from www.burk.com/downloads 

• An available port on an existing LAN  

 

REAR PANEL CONNECTIONS 

INPUTS AND OUTPUTS 

Connect the inputs and outputs to the rear panel using the supplied phoenix style plug in connectors.  

Note: Status and analog inputs share one ground between 2 channels. 

ETHERNET  

Connect the ARC Solo port marked ETHERNET to your LAN/WAN using CAT5e cable.  

AUDIO IN AND AUDIO OUT 

If desired, connect the AUDIO IN to a source of audio to be remotely monitored via RSI. Speech generated by the 

RSI may be fed to a paging system by connecting to the AUDIO OUT jack. 

  

http://www.burk.com/
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CONNECTIONS, CONTROLS AND INDICATORS  

FRONT PANEL 

 

 

 

REMOTE 

The Remote button enables maintenance mode. This is a safety feature to prevent remote commands 

while service is being performed. This mode can only be disabled from the front panel. 

ALARM LED 

The Alarm LED displays red when an alarm is present. When no alarm is present, the LED is green, 

indicating that power is on.  

 

REAR PANEL  

 

CONTROL RELAYS 

Phoenix-style plug-in connectors for common, normally open and normally closed contacts for sixteen 

relays. 

LINE 

Connects to the telephone line for dial up access. 

AUDIO OUT 

Audio from the RSI may be taken from this jack for annunciation. 
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AUDIO IN 

Audio may be fed to the RSI for remote monitoring via phone. 

SENSORS (RJ-25) 

This jack supports up to 4 Burk Technology temperature sensors with the STM-4D software option 

available for the ARC Solo. 

ETHERNET (RJ-45) 

The Ethernet jack connects the ARC Solo to the LAN/WAN for communications with the user. 

MASTER INIT 

Resets the unit to its factory default setting. This includes setting the IP network configuration to DHCP 

with the default hostname ARCSOLO. In units running firmware version 1.0.38 or higher, a master init does 

not clear the AutoPilot® authorization code. Press the recessed push button until the LEDs turn amber. 

Upon completion, the LEDs will flash. 

STATUS INPUTS 

Phoenix style plug-in connectors for 16 status inputs. 

METERING INPUTS 

Phoenix style plug-in connectors for 16 metering inputs. 

POWER 

Standard IEC power entry module. Connect to 100-240VAC, 47-63 Hz. Replace built-in fuse with same type 

and value. 
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MONITORING AND CONTROL 

WEB SERVER 

The ARC Solo includes a built-in web server 

for managing remote sites via web 

browser. From the web page of the ARC 

Solo you can monitor and run your unit 

without downloading any software to your 

PC. The web page is accessible by entering 

the hostname (or the IP address if DHCP is 

not enabled) of the ARC Solo in your web 

browser. For more on this feature, click or 

turn to NAVIGATING THE WEB PAGE 

The web server also provides connectivity 

to compatible mobile devices. For 

information on the mobile web interface, 

click or turn to SMARTPHONE WEB PAGE. 

AUTOPILOT® 

If you are using AUTOPILOT, you can monitor and control sites in 

real time, automatically log site parameters using the onboard log or 

Microsoft SQL server, automatically print or email reports to station 

personnel, build custom screens to tailor the software to your exact 

needs, and manage network devices using SNMP and ping. 

 

RSI (RECORDABLE SPEECH INTERFACE)   

The RSI Recordable Speech Interface provides dial-in monitoring, control and dial-out alarm notifications via a 

standard telephone line connection.  Click or turn to RECORDABLE SPEECH INTERFACE (RSI). 

The standard RSI vocabulary features pre-recorded speech tailored to the broadcast environment. Custom words 

or phrases may be recorded by the user on a PC and added via the web interface.   

Click or turn to CUSTOM SPEECH on page 27. 

See RSI SETTINGS for configuration. 
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JET ACTIVE FLOWCHARTS  

JET ACTIVE FLOWCHARTS allow you to describe automatic remote control 

functionality using simple, easy to read flowcharts. The user can design a wide range of 

automatic functions by drawing simple flowcharts to describe how the remote control 

should respond to different conditions. 

Jet Active Flowcharts software is included with your ARC Solo unit. 

 
 

CONFIGURATION 

All initial configuration is done via a web browser. The system tab of the web page provides access to metering, 

status, and command channel settings, calibration, user security, time and date settings, alarm notifications, RSI 

settings, macros, and more.  

Note: Only administrators have access to the system tab. 

FIRMWARE UPDATES 

Periodic updates to ARC Solo firmware, along with release notes, are made available on the Burk Technology 

website. To be notified when new versions are available, visit www.burk.com, select the Support page and sign 

up for email updates. 

SYSTEM SECURITY  

The ARC Solo uses HTTP authentication to secure the web pages. To avoid exposure to excessive network traffic, 

installation behind a router or firewall is required. The web server can operate on any port, allowing the firewall to 

block Port 80 if desired. 

 

 

 

 

 

 

 

  

 

http://www.burk.com/
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OPERATION 

The most straight-forward method of operation is via a web browser. AutoPilot also provides access to the ARC 

Solo, and is especially useful if the operation contains multiple sites with ARC Solo or other Burk Technology 

remote controls. This section contains instructions for using the built-in web page. The AutoPilot manual includes 

operating instructions if that method is being used.  

 

REQUIREMENTS 

The ARC Solo web page is designed to work on a PC or tablet such as an iPad. The web page does not require Java.  

SECURITY  

The ARC Solo uses HTTP authentication.  
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NAVIGATING THE WEB PAGE 

LOGGING IN AND OUT  

To connect to the ARC Solo, enter the hostname (or the IP 

address if DHCP is not enabled) of the ARC Solo in your web 

browser (ex. http://ARCSOLO). The first time you connect to 

the ARC Solo, you will be required to set an administrator 

password as shown below. The word “password” is not 

accepted as a password. 

 

 

 

 

 

Following this, and on subsequent logins, the login screen will appear. Enter your user name and password 

and click Log on.  

 

 

 

 

 

Use the Log Off link to end your session.  

CHANNELS  

When you first log on, the web interface will display 

the Channels page. This page displays your meter, 

status and command channels. Only unhidden 

channels will appear in the lists.  

A muted alarm icon will appear to the right of the 

meter or status channel number if the alarm is 

muted. Mutes are active for 4 hours but may be 

disabled immediately by unchecking the mute 

checkbox on the Meter Alarms or Status Alarms page 

in System>Setup. 

User names, passwords and privileges 

can be set up and modified in the 

System tab of the web interface.  The 

password cannot be set to 

“password”. 
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COMMANDS  

The command buttons can be viewed in groups if 

desired. On a typical display, channels 1-8 or 9-16 can 

be seen without scrolling. 1-16 shows everything, but 

may require scrolling. 

To remove all commands from view, select None. 

• 1-8 channels 

• 9-16 channels 

• 1-16 channels 

• None 

JET  

The Jet page displays the status of the Jet™ Active 

Flowcharts your ARC Solo has available. Each flowchart 

represents an automatic function that has been created for 

this site. For instructions on creating automatic functions, 

see JET ACTIVE FLOWCHARTS. 

Name Jet macro name 

Status Status of macro 

Run Initiate the macro by clicking the run button 

Stop Stop the macro by clicking the stop button 

 

 

 

ALARMS  

The Alarms page displays the alarms on this ARC Solo with the 

following fields: 

Date/Time The date/time when the alarm occurred. 

Duration The duration of the alarm, if it has been resolved. 

Severity The severity (warning or critical) of the alarm. 

Type The type of alarm (such as a status alarm or system 
alarm). 

Message A message describing the alarm description. 

Time 
Cleared 

The time the alarm was cleared, or blank if not 
cleared. 

Use the Clear link to clear an alarm, or Clear all alarms to clear 

all. Use the Show more or Show all links at the bottom of the page to display more alarms. When all alarms 

are displayed, “All alarms shown” will appear at the bottom of the page.  

 Jet 

Commands on the Channel page 

Alarms 
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EVENTS   

The Events page displays the ARC Solo event list.  Events are 

activities concerning the ARC Solo itself as opposed to 

reports from the equipment under control. 

Use the Show more or Show all links at the bottom of the 

page to display more events. When all events are displayed, 

“All events shown” will appear at the bottom of the page. 

 

 

 

SYSTEM  

The System page allows you to perform configuration and system related actions. This page is only 

available if an administrator is logged on.

 

Systems Page 

Events 
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BASIC SETTINGS 

 

Set the location name, enter authorization codes for 
AutoPilot and Arcadia, enable alarms and configure the 
alarm startup delay.   

Location Enter the site name to be displayed in 
AutoPilot® and on the web page. 

AutoPilot 
Authorization 
Code 

Enter the AutoPilot authorization code 
to allow AutoPilot to connect to this 
unit. Contact Sales (sales@burk.com) 
to purchase an authorization code.  

Arcadia 
Authorization 
Code 

Enter the Arcadia authorization code 
to allow Arcadia Server to connect to 
this unit. Contact Sales 
(sales@burk.com) to purchase an 
authorization code. 

NOC 
Authorization 
Code 

Enter the NOC authorization code to 
allow Arcadia NOC to connect to this 
unit. Contact Sales (sales@burk.com) 
to purchase an authorization code. 

Enable Site 
Alarms 

Enable site alarms for normal 
operation. Disable site alarms to 
suppress alarms during maintenance. 

Alarm Startup 
Delay 

Enter the desired number of seconds 
to delay alarms after startup 

 

 

System>Basic Settings 

 

METERS 

Configure each meter channel as described here.  

 

 

Chan Number of the meter input on rear panel 

Hide Hides the meter on the Channels web page 

Label Enter the name of the meter. 

Units Enter a unit label such as kW or deg.  

Decimal Use the Decimal Places column to select the 
location of the decimal place when the ARC 
Solo reports the channel reading.  

Low Critical If the meter drops below the value entered, 
a Critical alarm will be set. 

Low Warning If the meter is less than this value and more 
than the Low Critical value, a Warning 
alarm will be set. 

High Warning If the meter is greater than this value and 
less than the High Critical value, a Warning 
alarm will be set. 

High Critical If the meter rises above this value a Critical 
alarm will be set. 

System>Meters  

mailto:sales@burk.com
mailto:sales@burk.com
mailto:sales@burk.com
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METER DISPLAY 

Minimum and Maximum set the range limits on AutoPilot 

meters. These limits have no effect on the web page 

meters. 

Each meter can display up to five color zones, allowing 

you to depict a Low Critical up to a High Critical tolerance 

range on the AutoPilot meters and simulated LEDs on the 

channels web page. 

 

 

 

 

METER ALARMS 

Configure the meter alarms.  

Muted A check in this box mutes alarms for 4 hours. 

Label Enter the name to be displayed 

Alarm Enable Use the checkbox to turn on alarms 

Hysteresis This is a scaled value that the value must 
change before the alarm is rearmed.  

Alarm Delay This is the length of time in seconds that the 
value must be in the alarm condition before 
the alarm is logged. 

Rearm Delay Set the length of time for the alarm to rearm. 
The delay starts after it has been triggered 
and returned to its normal state. 

Email List Use the drop down menu to select a target 
email list. If an alarm is triggered, the 
personnel will be notified via email. 

Phone List Use the drop down menu to select a target 
phone list. If an alarm is triggered, the 
personnel will be notified via phone 
message. 

 

Note: Alarms will only be set if the condition is still present after the Alarm Delay. 

 

  

 

System > Meters 

System>Meter Display 

 

System>Meter Alarms 
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METER CALIBRATION 

Configure the meter channel Calibration value.  

Before calibrating a meter channel, select the meter type 

from the drop-down box. Note that channels set to 

“Millivolt” or “Degree” cannot be calibrated.  

Millivolt Cannot calibrate 

Linear Normal 

Positive Shows only values above zero 

Negative Shows only values below zero 

Power Squares the input 

Indirect Product of this channel and the previous 
channel 

Degree Temperature (cannot calibrate) 

Special Power For use with GatesAir Maxiva ULXT20 
transmitters 

 
 
To calibrate a channel, apply a voltage to that channel’s meter input on the rear panel of the unit. Click 
the Calibration value for the meter channel to be calibrated. A Calibrate Meter dialog box will be 
displayed, showing the current value of the meter display. In the New Meter Value field, enter the value 
that should be displayed to represent the currently applied voltage and click Calibrate.  

On ARC Solo units running firmware version 1.0.13 or newer, a filter can be enabled for each meter 

channel. The filter is selectable as None, Light, Medium or Heavy. This feature can be used to smooth 

short-term variations on incoming signals. A setting of None disables smoothing for that channel. After a 

Master Init action, all filters are set to the default value of None. 

 

STATUS 

Configure the Status channels. 

Hide Check the box to hide channels. 

Invert Check the box to reverse the sense of the 
input. 

On Label Enter a label to display for the ON 
condition of this status channel. 
Enter a label to display for the OFF 
condition of this status channel. 

Off Label 

 

Note: Clicking on the colored dot next to the On and Off 
Label, allows the user to change the color of the status 
indicator. 

 

 

 

 
System>Status 

 
 
 
 

System>Meter Calibration 
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STATUS ALARMS 

Configure the Status alarms.  

Muted Check the box to mute the alarm for 4 hours. 

On Label Enter a label to display for the ON condition of this 
status channel. 
Enter a label to display for the OFF condition of this 
status channel. 

Off Label 

Alarm 
Condition 

Sets the condition to trigger the alarm. Conditions 
are: disabled, when off, when on, and on change. 

Alarm Delay Set the length of time in seconds the alarm is 
delayed. 

Rearm Delay Set the length of time for the alarm to rearm. The 
delay starts after it has been triggered and returned 
to its normal state. 

Email List Use the drop down menu to select a target email 
list. If an alarm is triggered, addresses on the 
selected list will receive an email notification. 

Phone List Use the drop down menu to select a target phone 
list. If an alarm is triggered, this phone list will be 
used for alarm notification. 

 

 

 
System>Status Alarms 

 

COMMANDS 

Configure the Command channels.  

Hide 
Check the box to hide command buttons for 
this channel. 

Lower Label  Enter a label for the lower relay 

Raise Label Enter a label for the raise relay 

Pairing 

Set the pairing of two channels Unpaired 
relays have only one relay per channel. Paired 
relays include a second relay from the second 
bank of 8. 

Momentary/Latching 

Momentary relays will turn on for the 
duration when the command is pressed. 
Latching relays will turn on with the on 
command and stay on until the off command 
is received. 

Duration 

Set the length of time the relay is active for a 
momentary command. The minimum allowed 
setting is 100mS, to ensure reliable relay 
actuation. 

 

 

System>Commands 

 
 

Relay behavior  

Pairing Momentary/Latching Raise Command Lower Command 

Single Momentary Raise relay closed for selected 
duration  

None 

Single Latching Raise relay closed until changed Raise relay open until changed 
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Paired Momentary 
Raise relay closed for selected 
duration,  
Lower relay open 

Lower relay closed for duration,  
Raise relay open 

Paired Latching 
Raise relay closed until changed 
Lower relay open 

Lower relay closed until changed 
Raise relay Open 

 

 

 

SENSORS 

ARC Solo supports the STM-4D temperature module, making use 
of the sensor port on the rear of the ARC Solo. Up to 4 
temperature sensors can be connected and mapped to ARC Solo 
meter channels. When a temperature sensor is mapped to a 
meter channel the wired input to that channel is disabled. 
Detailed information regarding the STM-4D option can be found 
in the STM-4D manual here: www.burk.com/downloads 

 

Sensors 
Authorization 

Enter the AutoPilot authorization code to 
allow AutoPilot to connect to this unit. 
Contact Sales (sales@burk.com) to purchase 
an authorization code.  

Sensor ID  
Each sensor connected to the sensor port is 
identified by a unique Sensor ID. 

Map to Channel  

Select an ARC Solo meter channel for each 
temperature sensor. The wired input 
normally associated with the selected 
channel will be disabled. 

Temperature 
Displays the current temperature reading for 
each sensor. 

Connection 
Indicates whether the sensor is currently 
connected or disconnected. 

Temperature Sensor 
Units 

Set the temperature display to either Celsius 
or Fahrenheit. 

 

 

System>Sensors 

 
 

https://www.burk.com/assets/burk/products/STM-4D_Manual_Rev_B.pdf
mailto:sales@burk.com
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NETWORKING 

Use the Networking page to set the networking 
parameters on the ARC Solo.  
 

NetBIOS name 

The hostname used on a local network when 
DHCP is enabled. The default hostname is 
ARCSOLO. If multiple ARC Solo units are on 
the same network, make sure that each unit 
is assigned a unique hostname. A blank 
hostname cannot be saved if the Use DHCP 
box is checked. Hostnames may include only 
letters, numbers and hyphens 

Use DHCP 

Automatically assign network configuration 
parameters. DHCP is enabled when the unit is 
shipped from the factory and is re-enabled 
any time a FACTORY DEFAULT action is 
initiated or the MASTER INIT button on the 
rear panel is depressed.  

IP address The current IP address of the unit. 

Netmask 
The subnet mask associated with the IP 
address. 

Gateway 
The IP address of the router connected to the 
local network that sends packets out of the 
local network. 

Primary DNS 
The first domain name server to resolve 
hostnames to IP addresses. 

Backup DNS 
The second domain name server to resolve 
hostnames to IP addresses. 

HTTP Port 
The port number to use for the web page. By 
default this is port 80. 

 

System>Networking 
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WARP ENGINETM 

The settings on this page control the interaction of ARC 
Solo with the Warp Engine polling feature in AutoPilot®. 
ARC Solo units running firmware 1.0.29 or later are 
compatible with the AutoPilot Warp Engine.  
 
Warp Engine polling is fast. As an example, Warp Engine 
can monitor up to 100 sites per second with each site 
reporting as many as 32 status and/or meter values while 
also supporting command execution. Larger networks just 
take a little longer, for example polling up to 500 sites in 5 
seconds. Warp Engine polling is efficient in its use of 
communications bandwidth. It uses very small packets, 
sending only required data and minimizing 
communications overhead. Polling 32 channels from 100 
sites requires only 37,800 bytes per second of IP capacity 
at the central site, and only 378 bytes per second at each 
remote site. If communications bandwidth is at a 
premium cost, it can be further reduced by selection of a 
slower poling rate. 
 

Enable Warp 
Engine Polling 

Check this box to permit AutoPilot Warp 
Engine polling on this ARC Solo unit. The box 
must also be checked before any other edits 
can be made on this page. 

Port 
The UDP port to be used for Warp Engine 
Polling.  

Change 
Password? 

Password-based credentials are exchanged 
between AutoPilot and the ARC Solo for 
secure Warp Engine polling. To assign or 
change the password, check this box, enter 
the desired password in the boxes below and 
click the ‘Save” button. 

 

System>Warp EngineTM 
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SNMP 

The ARC Solo can be enabled to send SNMP Traps 
and to respond to an SNMP System Description Get-
request.  
 
Up to 64 different SNMP Trap messages can 
be configured based on user-selected alarm 
types for user-specified channels. The SNMP 
page allows configuration of these alarms as 
well as identification of up to four SNMP 
managers to receive the Trap messages. 
 
Each Trap is defined by a sequence of dot-
separated numbers known as an OID (Object 
Identifier). The page allows construction of an 
OID for each desired Trap. 
 

If SNMP is enabled and the correct Read Community 
String is provided, ARC Solo will respond to an SNMP 
Get-request for the standard parameter “SysDescr”. 

 

System>SNMP 

 

 

The ARC Solo’s response will include a character string, as follows: “xxx - ARC Solo” where “xxx” is the 
name that has been assigned to the ARC Solo Location as set in menu System/Basic Settings (see 
BASIC SETTINGS). The location part of the string can be from zero to 50 characters in length. 
 

Note: SysDescr (an abbreviation for System Description), is defined in the industry standard MIB-
2. Its object identifier (OID) is 1.3.6.1.2.1.1.0. 
 

Enable SNMP  
This box must be checked before other fields on the page can be entered. Traps and Get 
requests are enabled and disabled using this checkbox.  

Read Community 
String 

This string must be supplied by the SNMP network manager to the ARC Solo as part of a Get-
request.  The user can change the default value from “public” to a user-defined text 
string.  The maximum length is 30 characters. Strings are case sensitive. Special characters 
cannot be used, including plus (+), backslash ( \), forward slash (/), brackets ({ } ), single quotes 
(‘ ’), double quotes ( “ ”), comma (,), and question mark (?).  It is recommended that you use 
only letters and numbers. 

SNMP Managers 

Up to four SNMP managers can be identified by either IP Address or Hostname. A UDP port 
number and Community String must be specified for each manager. The default port number 
“162” and default Community String “public” are frequently used. Check with your network 
administrator for the settings required by your network management system. 

Enterprise 
Number 

The Enterprise ID number entered here will become part of the Trap OID for each of the Traps 
configured on this page. This number is typically 1 to 5 digits with no internal dot separators. 

Repeat Traps 
The SNMP traps specified on this page can be sent repetitively duration the time their 
associated alarms are active. When checked, a value between 1 and 255 must be entered to 
specify the desired repetition interval in seconds.  

Trap OID 
A Trap OID must be entered for each specified Trap. The Trap OID must start with a digit and 
be followed by a set of dotted numbers with no concluding dot. The Trap OID for each Trap 
should be unique. 

Alarm Type 
This field identifies the type of channel alarm that will cause the associated trap to be 
transmitted. The selection in this field affects the choices that are made available in the 
adjacent Channel drop-down box.  

Channel 
This drop-down box identifies the channel to associate with each Trap OID.  The channels 
available for selection in the drop-down box will be Meter channels or Status channels 
depending on the selection in the adjacent Alarm Type field. 
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EMAIL 

Set up the Email server and configure the SMTP settings for your ARC Solo. For support of encryption levels 

higher than SSLv3, ARC Solo firmware version 1.0.19 and above now supports the Burk Email  

Cloud Service. The Cloud Service works in conjunction with your ARC Solo system to originate encrypted 

emails using the STARTTLS protocol extension. If your current email server does not support STARTTLS, you 

can open a free email account with an Internet email service provider. The Burk email cloud service is 

compatible with email services from a wide range of providers such as Gmail, mail.com, GMX and Zoho. It 

is suggested that you create an email account dedicated for use with your ARC Solo systems. This will make 

it easier to identify and sort email received from the ARC Solo systems, and to monitor email activity. To 

configure the ARC Solo system for use with the cloud service, select Cloud Service STARTTLS as indicated 

below. 

 

Email server 

Email server IP address. Obtain from 
your network administrator. If using 
the Burk Email Cloud Service, enter an 
SMTP server such as smtp.gmail.com. 

Email port 
The port number to use for the email 
server. By default this is port 587. 

From 
Emails originating from the ARC Solo 
must have a From address. 

Reply To 
Any undeliverable notifications will be 
sent to the Reply To address. 

SMTP server 
requires security 

Check this box if your email server 
requires authentication or if you are 
using the Burk Email Cloud Service. 

Username/Password 
Enter your email username and 
password. 

SMTP protocol 
Choose plain text, SMTP over SSL or 
STARTTLS email format, or select  
Cloud Service. 

Cloud Server 
Accept the default Cloud Server, 
cloud.burk.com. 

Cloud Port Accept the default Cloud Port, 4095. 
 

System>Email 

 

  

 

EMAIL LISTS 

Manage email lists and addresses. 
 

List name 
Enter a title to be displayed for each 
email listing. 

Email addresses 
Enter one or more email addresses. 
Separate each email address with a 
semicolon (;). 

Test 
Test each list to confirm it works 
properly. 
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JET EMAIL TEMPLATES 

Jet email templates permit detailed email messages 
to be sent when user defined conditions occur. 

 
Template Tokens – for tokens requiring a channel 
number, replace the [n] with the channel number (ex. 
%m1 for meter channel #1). 
Tokens %site Location Name  

%time Local Time 

%date Current Date 

%macro[n] Macro Label  

%mrun[n] Macro Status  

%mlabel[n] Meter Label 

%munits[n] Meter Units 

%m[n] Meter Value 

%s[n] Status Value 

%v[n] Macro Variable Value 

Note: substitute the number for the channel or macro 
for [n]. e.g. %macro1 or %s3 

 

System>Jet Email Templates 

CONFIGURING JET EMAIL TEMPLATES (MACROS) 

Jet email templates allow you to send customized email messages containing site and 

channel data. Use the list of tokens above to create your email templates. 

For example, to send an email stating the value of channel 1 and the site name, use the 

following syntax:  

%mlabel1 on %site = %m1%munits1 at %date %time 

Assuming channel 1 is “Forward Pwr”, the email message will be similar to the following:  

Forward Pwr on WXYZ = 2950W at 1/1/2012 9:15:00 AM 

Use the drop down menu to select the email list to send to.  

When that macro command is triggered, the ARC Solo will use the selected 

template to send an email to the list specified in the macro command. 

 

  

Select an Email List 
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PHONE 

Configure the Phone interface parameters. 
 
Choose from the vocabulary list for the following phone 
messages: 
Greeting The greeting message is spoken after the phone 

number is dialed or the phone is answered. 

Welcome The welcome message is spoken after a user 
successfully logs into the phone interface. 

Rejection The rejection message is spoken if a user does 
not log in correctly. 

Goodbye The goodbye message is spoken when the user 
logs out of the phone interface. 

 

System>Phone 

 

PHONE LISTS 

Manage Phone Lists and numbers 
 

List name Enter a list name to be displayed for each 
phone list. 

Phone numbers Enter one or more phone numbers, separate 
each phone number with a semicolon (;), 
enter a comma (,) for a 2 second pause.  

Repeat A repeat phone list will loop through all the 
phone numbers until the alarm is cleared. A 
non-repeating phone list will call each phone 
number once and then stop. 

 

 

System>Phone Lists 

 

METER SPEECH 

Configure the Meter Channel Speech phrases. 
  
Choose from the vocabulary to program the label and units 
for each meter. 
 
 
Additional words or phrases may be added to the RSI 
vocabulary using the speech editor. Reference the Custom 
SPEECH section of this manual. 
 

 

System>Meter Speech 
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STATUS SPEECH 

Configure the Status channel Speech phrases. 
  
Choose from the vocabulary to program the label and units 
for each status channel. 
 
 
Additional words or phrases may be added to the RSI 
vocabulary using the speech editor. Reference the Custom 
SPEECH section of this manual. 
 

 

System>Status Speech 

JET SPEECH 

Configure the Jet Speech phrases. 
  
Choose from the vocabulary list to provide speech labels for 
each of the Jet Active Flowcharts you have created. 
 
 
Additional words or phrases may be added to the RSI 
vocabulary using the speech editor. Reference the Custom 
SPEECH section of this manual. 
 

 

System>Jet Speech 
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CUSTOM SPEECH 

The vocabulary shipped with 

the RSI is taken from the 

broadcast industry vernacular, 

but of course doesn’t include 

words and phrases specific to 

your site. By being able to use 

words you’ve recorded, the 

RSI adapts to your needs.  

System>Custom Speech 

ARC Solo firmware version 1.0.27 and higher allows addition and deletion of individual custom phrases 

directly from the web interface as shown here. In addition, it is now possible to download the complete 

custom speech vocabulary from the ARC Solo to your PC for offline editing, and to upload (restore) the 

entire custom or standard vocabulary directly from your PC to the ARC Solo, using the web interface. This 

feature makes it possible to create or modify entire custom vocabularies at your desk or in a studio 

setting. You can then deploy the new vocabulary to ARC Solo and ARC Plus systems throughout your 

network.   

You’ll need a PC program to record the custom phrases as 16-bit 8 kHz mono WAV files, each less than 8 

seconds in duration. Whatever your station uses for a Digital Audio Workstation (DAW) is fine, but if that 

is not convenient, Audacity is free and works just fine. See RECORDING ADDITIONAL VOCABULARY for 

hints on creating custom WAV files. 

To view a list of standard phrases: 

Check the Show Standard Phrases checkbox. This list allows you to see phrases that are already defined. 

 

System>Custom Speech>Show Standard Phrases 
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To add a custom phrase: 

Click the Add Phrase button and browse to the WAV file to be added. If you want to change the display 

text for the custom phrase, check the Edit checkbox and type a unique name in the Display Text box to 

identify the phrase in the custom vocabulary list.  Click Add. If the selected file has the proper format (16-

bit 8kHz mono WAV file) and does not exceed the maximum allowable duration (8 seconds) it will be 

uploaded and added to the custom vocabulary. 

 

System>Custom Speech>Add Phrase 

To delete a custom phrase: 

To delete a custom phrase, select the phrase from the drop-down box next to the Delete Phrase button, 

and click Delete Phrase. After a confirmation dialog, the selected phrase will be deleted from the custom 

vocabulary. 

To download the custom vocabulary for offline editing: 

To edit the custom vocabulary offline, click Download on the Custom Speech screen and click Download 

again on the following confirmation screen. 

 

System>Custom Speech>Download 

Find the downloaded file named Custom.bin on your computer and edit the file, as described in OFFLINE 

EDITING OF CUSTOM SPEECH VOCABULARY.  

To upload vocabulary files after editing: 

To upload the file after editing, click Upload. On the Upload Custom Vocabulary screen, click Choose File, 

browse to the Custom.bin file on your system, and click Send to upload the vocabulary file. 

 

System>Custom Speech>Upload 
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To download the standard speech vocabulary: 

Select Advanced on the System page and click Download Standard Vocabulary. The file, named 

Standard.bin, can be saved in a directory of your choice. This file cannot be edited or modified. 

.  

To upload a copy of the standard vocabulary: 

Select Advanced on the System page and click Upload Standard Vocabulary.  Click Choose File and 

browse to the file named Standard.bin on your system. Click Send. 
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CALENDAR 

Configure the Jet Flowchart Calendar times. 
  
The Calendar allows six preset times of day, per month (Pre- 
Sunrise, Sunrise, Sunset, Post-Sunset, User 1 and User 
2). Set up the schedule by typing the desired time. 
When a Flowchart references one of these preset times, it 
will use the time-of-day entered here. Use standard time 
when programming the calendar; the ARC Solo will 
automatically adjust for Daylight Saving Time if configured 
to do so. See the TIME Section.  

 

System>Calendar 

TIME 

Set the Time and configure SNTP and time zone settings. 
 
  
Program the SNTP settings, time zone and daylight saving 
time settings. 

 
Note: Using an SNTP server is recommended to ensure accurate 
timestamps and scheduled operations. 

 

System>Time 

UPLOAD FIRMWARE 

BEFORE UPDATING THE ARC SOLO FIRMWARE, SAVE YOUR CURRENT 

CONFIGURATION 

1. Open a browser, put in the IP address of the ARC Solo and login to the web page with the 

admin account. 

2. Click System>Advanced>Download configuration. 

3. Save the file, MasterCfg.json, in a convenient location on your computer. 

DOWNLOAD AND INSTALL BURK FIRMWARE LOADER V1.0.9 OR NEWER (IF NOT 

ALREADY INSTALLED) 

NOTE: By default, only members of the Administrators group on a computer can install new software. If you 

do not have the rights to complete all steps of this process, please contact your system administrator. 

2. Go to www.burk.com/downloads and select the Burk Firmware Loader section. 

3. Download Manual – Burk Firmware Loader and follow the Burk Firmware Loader 

Procedure to upgrade the ARC Solo firmware. 

 

http://www.burk.com/downloads
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VERIFY FIRMWARE VERSION AND CONFIGURATION SETTINGS 

Note: If the ARC Solo detects corruption in the on-board configuration data during the firmware update 

process, it will restore affected settings to factory default values. This may include network configuration 

settings.  

1. Open a browser and address the ARC Solo using its previously configured IP address or 

hostname.  

2. If the system does not respond, repeat the access using the default hostname ARCSOLO, 

with access credentials “admin” and reset the administrator password when prompted. 

3. Restore system configurations by selecting System>Advanced>Restore configuration.  

4. Check Restore network settings and Restore User Settings. 

5. Browse to and select the MasterCfg.json file saved at the beginning of this procedure. 

6. Click Restore. The message “Uploading configuration data. This may take some time…” will 

be displayed. 

7. When the Restore successful dialog is displayed, click OK.  

8. Confirm that you can access the web page using the original network settings. 

9. Select System>System Information to confirm that the correct firmware revision is in 

place. 
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USERS 

Manage User accounts and passwords. The 
maximum number of user accounts is 20. 

 
User Access Levels 
Administrator Allows commands and access to all 

setup and configuration 

Operator Allows commands but not setup 

Observer Allows read only access to the site 
 

Note: User passwords cannot be set to “password”. 

 

System>Users 

SYSTEM INFORMATION 

View the following System Information. 
 

Serial Number 

MAC Address 

Version 

ARC Solo Manual 
 

 

System>System Information 

ADVANCED 

Manage alarms, events, configuration and 
vocabulary and reboot the system. 
Factory default Perform a factory default to clear all 

the settings and logs. The operation 
cannot be undone. 

Reboot Perform a remote soft reboot. 

Clear the event 
log 

Clear all the entries in the event log.  

Delete all 
alarms 

Permanently deletes all the alarms.  

Download 
configuration 

Save a local copy of the 
configuration.  

Restore 
configuration 

Restore the configuration from a 
saved file. 

Download 
Standard 
Vocabulary 

Download the standard speech file 
from the ARC Solo. 

Upload 
Standard 
Vocabulary 

Upload the standard speech file to 
the ARC Solo. 

 

 

System>Advanced 
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RESETTING TO FACTORY DEFAULTS  

The Reset to Factory Defaults link will reset the ARC Solo to its factory default settings. The 

page will show a confirmation. 

Performing this action resets back to the default domain name http://192.168.0.100/. 

REBOOTING  

The Reboot link will reboot the ARC Solo. You will see a confirmation prompt before the 

system reboots. 

  

 

WARNING: Resetting the ARC Solo to factory defaults will erase all of your configuration 
and data from the unit. This operation cannot be undone. It is strongly recommended 
that you create a back-up first.  

http://192.168.0.100/
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SMARTPHONE WEB PAGE  

The ARC Solo smartphone-optimized web page is automatically delivered when the 

ARC Solo is accessed via iPhone, Android and other popular smartphones.  

To access the smartphone interface, enter the URL for your ARC Solo. For example, if 

your ARC Solo’s hostname is ARCSOLO, navigate to:  

http://ARCSOLO/  

Be sure to include the trailing “/”. 

If DHCP is not enabled on the ARC Solo, then the unit’s assigned IP address should be 

used in place of the hostname. 

The smartphone interface is designed for use on a smartphone or other small format 

mobile device.  

 

 

SECURITY  

The mobile web page uses the same security as the standard web page.  

NAVIGATING  

When you log on to the smartphone interface you will see the Channels page. This page displays your 

meter, status and command channels in a vertical list. If you have more channels than fit on one screen, 

scroll down to see more channels.  

 

Use the Menu link to display the additional features available in the smartphone interface: 

Channels Displays meter, status and command channels. This is the starting page. 

Jet Displays and controls the Jet Active Flowcharts on this ARC Solo and their current status.  

Alarms Displays all alarms on this ARC Solo. Alarms are displayed in a vertical list, with each field on its own line. 

Events Displays the event list. 

Log Off Logs off the smartphone interface. 

  

Smartphone webpage 

on the iPhone 
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JET ACTIVE FLOWCHARTS 

Jet Active Flowcharts allow you to describe automatic remote control functionality using simple, easy to read 

flowcharts. Flowcharts can be run from the Jet tab, on a schedule or when initiated by other flowcharts.   

Install and Configure AutoPilot® 

Jet Designer is part of the AutoPilot software. It is not necessary to purchase AutoPilot to write flowcharts for ARC 

Solo, as Jet is provided as standard. If you have not already done so, visit www.burk.com/downloads and select the 

support page for AutoPilot. Download and install the latest version of AutoPilot and download the AutoPilot User 

Guide. 

Before creating a Jet Active Flowchart, you must add your ARC Solo site to AutoPilot. Refer to “Adding ARC Solo 

Networks” in the AutoPilot User Guide for instructions on running the ARC Solo Network Wizard. If your ARC Solo 

has been configured with an AutoPilot license, you can connect to it using the green Connect icon: . However, 

this step is not necessary for creation of Jet Active Flowcharts that run on the ARC Solo unit. 

 Create a New Flowchart 

To run Jet Designer, select Jet from the Tools menu in AutoPilot. In Jet Designer, select 

New from the File menu. Jet will prompt you for a flowchart target. You can choose Run 

this flowchart on an ARC Solo. If your ARC Solo has been configured with an AutoPilot 

license, you will also be able to select Run this flowchart in AutoPilot. It is generally 

preferable to run the flowcharts on the ARC Solo, so that a computer does not need to 

be running for automatic functions to work.  

For complete instructions and a tutorial on Jet Active Flowcharts with examples, see the 

“Jet” section in the AutoPilot User Guide. 

 OPENING AN EXISTING FLOWCHART 

To open an existing Active Flowchart, click AutoPilot Active Flowchart... from the Open submenu under the File 

menu. 

 SAVING THE FLOWCHART 

After designing your flowchart, click Save from the File menu to save your flowchart. 

Select the macro location where you want to save the flowchart, and give it a name.  

 

 

Saving a flowchart that is running will cause Jet to stop the flowchart. If the flowchart is not scheduled to 
run, you will need to restart it manually. 

 

For Flowcharts in AutoPilot, Jet will only run flowcharts from the Jet directory. Do not save flowcharts in 
any other location. 

Saving a flowchart on ARC Solo 

Flowchart Target 

http://www.burk.com/downloads


 

36 

 CALENDARS  

You can schedule flowcharts to run at different calendar times. 

Jet allows you to define multiple calendars. To add, remove or 

edit a calendar, click Manage Calendars from the Tools menu in 

Jet. 

 

 

Note: Jet calendar times are always in standard time for the time zone configured on the PC.  

RECORDABLE SPEECH INTERFACE (RSI) 

Your ARC Solo is equipped with the RSI Recordable Speech Interface. You can take advantage of the dial-in and 

dial-out capabilities to monitor and control your site from any phone. If you are familiar with the earlier ESI Plus 

speech unit, you will find the RSI operates using the same familiar commands. Physically, the data access 

arrangement (DAA) and transient protection are located on a separate field-replaceable card. There are several 

enhancements, but the most noticeable is the ability to add custom vocabulary to the standard broadcast specific 

list. This is covered in the CUSTOM SPEECH section. The RSI comes from the factory with a default greeting 

“Hello”, default welcome message “Thank You”, default goodbye message “Goodbye” and default rejection 

message “Error”. 

CONFIGURING THE RSI  

Before you can use the RSI for monitoring and control, some configuration steps are necessary. You must 

specifically assign channel and unit speech labels, greeting and goodbye messages; and passcodes for the users. 

For alarm notification you will also need to set up the selective dial-out lists.  

There are also default settings that you may adjust, such as number of rings before the ESI answers an incoming 

call, the amount of time the RSI waits between phone numbers on the dial out list, etc. All of these may be edited 

via web browser and are described fully in RSI SETTINGS. 

CALLING THE RSI 

Calling in to the RSI allows you to monitor and control your ARC Solo if you have appropriate permissions. To place 

a call to the RSI: 

 New 
Calendar 

Creates a new calendar.  

 Save Saves changes made to the selected calendar.  

 Delete 
Calendar 

Deletes the selected calendar.  

 Calendar Select a calendar from the drop down list to display it in the editor.  

 Close Closes the calendar editor.  

Jet Calendar 
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1. Dial the phone number for the line connected to RSI. After the specified number of rings, the RSI will pick 

up the line and speak the programmed greeting.  

Enter your assigned passcode. If you 

make a mistake, press * to clear the 

entry and start over. If you enter an 

incorrect passcode, the RSI will speak, 

“Error,” and you can try again. Once 

you begin entering the passcode, you have 20 seconds to finish before the RSI disconnects. The durations 

allowed to begin entering the passcode and to complete the entry are configurable on the System>Phone 

page. See PHONE. If your ARC Solo is running a firmware version older than 1.0.27 it is necessary to press 

the # key after entry of your passcode. 

2. Once you enter your passcode, the RSI will speak the user-programmed welcome message, followed by 

the name of the site in which the RSI is installed and the number of alarms present at that site. After you 

log in, the RSI waits for a user command. For a list of commands, Click or turn to RSI COMMAND LIST.  

RSI SETTINGS 

 Passcodes are assigned in System>Users on the web page. Telephone speech properties are configured under 

System>Phone on the web page. 

CHANNEL SELECTION AND METER READINGS  

Once the desired site is selected, you can choose a channel for readings and commands by entering the channel 

number (1-16). The RSI speaks the name of the metering channel, the current value, and the unit label.  

To repeat a channel reading at any time, dial 000.  

Shortcut: When entering channels, you can speed up the selection process by entering 001-016.  

ISSUING COMMANDS  

After selecting the desired channel, you can issue a raise or lower command to that channel by pressing # for raise 

or * for lower. The RSI will confirm your entry by saying, “raise,” or, “lower.” You can then issue another raise or 

lower command, or enter any other RSI command. For an updated metering reading at any time, enter 000.  

REVIEWING STATUS CONDITIONS  

To hear a report of all status channels at the site with a status ON, enter 350. The RSI will speak all Status On 

messages. The ESI will announce the end of the report when you have heard the last status message. You can 

interrupt and exit a status report at any time with a new RSI command, including 000 to repeat the selected 

channel’s meter reading. Entering 350 again will start a new status report. 

  

A passcode must be assigned on the System>Users 

web page before calling in to the RSI.  



 

38 

REVIEWING ALARMS 

When the RSI dials out to report an alarm, it will speak the name of the alarm that prompted dial-out as soon as 

you log in. At any time, you can access a list of all alarms at the site by entering 300. The RSI will report the number 

of alarms at the site, and then read the first alarm in the list. The RSI waits for your input after each alarm. You 

have the following choices: 

# Clear the alarm and go on to the next one. 

* Leave the alarm active (not cleared) and go on to the next one. 

# # # Clear all alarms at the site. The RSI will prompt you to confirm before clearing all alarms. 

You can temporarily suspend alarm notification on any active alarm by pressing * followed by the desired number 

of hours (1-9). For example, press “*4” to put alarm notification on hold for four hours. After four hours, if the 

alarm is still active, the RSI will begin dialing out for this alarm once again. This method allows operators to ignore 

an alarm for a period of time without clearing it. 

The RSI will tell you when it has reached the end of the alarm report. You can then enter any command. 

RUNNING MACROS (JET ACTIVE FLOWCHARTS)  

You can use the RSI to run or stop macros that are saved to the ARC Solo unit.  

To run or stop macros:   

If a macro executes for a very brief duration, it is possible to issue a run command only to hear the RSI announce 

the new status as “stopped.” This may happen when the macro completes its last line of code before the RSI 

queries the new macro status.  

Besides running and stopping macros, you can listen to a list of currently running macros by entering 600. The RSI 

will read the names of macros that are stored on the selected unit and running at the moment you enter your 

query. Macros that stop during the macro report will be reported as running.  

 

  

1 Log in to the RSI.  

2 
Choose a macro by entering a macro preset number 601-698. If you wish to select a macro from a 
menu, dial 699.  

3 
The RSI announces the name of the macro you selected, and whether the macro is running or 
stopped. 

4 
To run the macro, press #. To stop the macro, press *. The RSI will confirm your selection and read 
the macro status after it runs or stops the macro. 

5 When you are done with macros, dial 000 to exit and repeat the current metering channel reading. 
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AUDIO INPUT MONITORING  

Line level audio applied to the rear panel RCA jack labelled 

AUDIO IN may be monitored over the phone. This is commonly 

used for monitoring program audio or room noise. 

You may begin monitoring by following these steps: 

1. Log in to the RSI.  

2. Dial 994 to begin monitoring the audio input.  

3. Dial 995 to turn the audio off. 

Audio monitoring will stop automatically 30 seconds after the last entry of command 994. 

 

ONBOARD HELP  

Built-in voice guidance on the RSI operates in either of two modes, terse or verbose. Verbose mode is designed to 

help novice users navigate the various functions. The RSI confirms each command, speaks a context-sensitive help 

prompt after each command, and prompts the user for a new command after a period of inactivity. Terse mode is 

for advanced users who need minimal prompting. The RSI will confirm each command, and will only prompt for a 

new command just prior to disconnecting.  

The RSI operates in verbose mode by default. To switch to terse mode, dial 997. The RSI will remain in terse mode 

for this and subsequent sessions, until a user dials 996 to switch back. In addition to the context-sensitive prompts 

in verbose mode, any user can summon a complete list of available commands by entering 998. The RSI will read a 

list of commands. You can interrupt the list with a new command at any time. The RSI will finish reading the 

current phrase before executing the new command. 

COMMAND TIMEOUTS  

When the RSI expects input from the user, it will wait 60 seconds before disconnecting. If you need more time to 

enter a command, enter 993.  

DISCONNECTING  

When you are done using the RSI, enter 999. This makes the line immediately available for new calls. If you hang 

up without disconnecting, it may take 60 seconds or more for the RSI to release the phone line on its own, 

depending on the duration of the command timeout setting. 

 

WARNING: You may be able to issue commands while the audio is playing. However, depending on the 
signal level it is possible for the audio input to overpower the DTMF. 

TIP: 

To monitor multiple stations or points in 

the audio chain, use an audio switcher 

controlled by the ARC Solo. 
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RSI COMMAND LIST 

 

Login  Once the RSI starts speaking, enter the system or user passcode 
then press #.  

Channel Selection  
1-16 

# 
* 

Select Channel  
Raise  
Lower 

Alarm Report  

300 
# 

# # # 
* 

*1 - *9 

Begin alarm report 
Clear last alarm spoken 
Clear all alarms on this site 
Advance to next alarm without clearing 
Mute current alarm for 1-9 hours 

Status Report  
350 

* 
Begin status report 
Advance to next status message 

Macros  

600 
601-698 

699 
# 
* 

Report currently running macros 
Select macro by preset number 
Select macro by using voice menu 
Run selected macro 
Stop selected macro 

Special Functions  

993 
994 
995 
996 
997 
998 
999 

Extend command entry timeout 
Enable audio input monitoring 
Disable audio input monitoring 
Verbose mode (extensive guidance) 
Terse mode (limited guidance) 
Summon help prompt 
Disconnect 



 

41 

OFFLINE EDITING OF CUSTOM SPEECH VOCABULARY  

As described in CUSTOM SPEECH, individual WAV files can be added to or 

removed from the custom speech vocabulary using the web interface. This 

section provides tips for creation of appropriate WAV files and instructions for 

offline modification of the custom vocabulary files using AutoLoad Plus, 

revision 3.1.83 or higher.  

VOCABULARY FILE 

The custom vocabulary is stored in the Custom.bin file.  

See CUSTOM SPEECH for instructions on downloading the file from the ARC Solo and restoring it to the ARC Solo 

after editing.  

RECORDING ADDITIONAL VOCABULARY 

Use your DAW to record each word or phrase as desired. You must set the editor to produce 16-bit mono wave 

files at an 8 kHz sample rate. Stereo or any other rate will result in an error. If you are using Audacity, you can set 

the default sample rate and sample format by going to Edit>Preferences which opens the Preferences: dialog box. 

Choose the Quality tab and set the defaults as shown. 

 

Audacity Edit>Preferences - Quality 

Edit the recording to produce separate wave files for each word or phrase. Trim the recordings to produce 

consistent heads and tails with only a few tens of milliseconds of silence. Give each file a filename that represents 

the recorded word or phrase. The file name will become the exact entry in the vocabulary list. Normalize the 

recordings to full amplitude so that the recordings will match the standard vocabulary in level. 

All files must be less than 8 seconds in length. 

  

Not an announcer? 

Let your production 

department record your 

custom vocabulary. 
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SAVING THE VOCABULARY 

The Speech editor in AutoLoad Plus will update the custom speech file as needed. AutoLoad Plus version 3.1.83 or 

greater must be used. To obtain the latest version of AutoLoad Plus, visit www.burk.com/downloads and select the 

support page for AutoLoad Plus.  

In AutoLoad Plus, select Tools>Speech Editor. This will open the Browse For Folder dialog box where you can select 

the folder where you saved the custom vocabulary file.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Select Tools>Speech Editor 

http://www.burk.com/downloads
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Click OK to edit this folder. The speech editor will open as shown here. 

 

Check the Show Custom Phrases checkbox at the top right of the dialog box. You can further restrict the displayed 

list using the Search box.  

To add a recorded phrase, click the Add button. Then Select a mono, 16-bit, 8kHz WAV file to import dialog box 

opens. Select the desired file and click the Open button. This will add the file to the vocabulary. 

 

To rename, update (replace) or delete a phrase, right click on the phrase name in the Speech Editor.  

After all modifications have been completed, click the Save to Folder button on the Speech Editor to write the files 

to disc. Refer to CUSTOM SPEECH to restore the custom vocabulary file to the ARC Solo. 
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APPENDIX A: SPECIFICATIONS  

 

Operating Temperature 0o to 40oC 

Power Requirements 
100 to 240VAC, 47–63Hz, 1A; Power entry module with standard, grounded 

power cord supplied; 1A fuse protection 

Dimensions (WxHxD) 19” x 3.5” x 12” (48.26cm x 8.89cm x 30.48cm) 

Channels 16 status, 16 metering, 16 relays 

Metering Input Range 
-10 to +10VDC 
> 99.75% accuracy, full scale 

Status Input Range 
0 to +28VDC or switch closure 
<0.5 VDC = ON; >2.1 VDC = OFF 

Relay Contacts Form C; momentary or latching; max 5A, 240VAC 

Front Panel Indicators Red/Green LEDs for alarm, remote, power indicator by any lit LED 

Front Panel Control Remote (maintenance lockout) 

Rear Panel Control 

Combicon: 
16 Relay Contacts (48pins) 
16 Status Inputs (24pins) 
16 Meter Inputs (24pins) 
RJ-11: Telco 
RCA Phono: Audio Out, Audio In 
RJ-45: Ethernet 
RJ-11: Sensors (future) 
IEC: Power 

Communications Ethernet, web server, dial-up 

Telephone Interface 
RSI Recordable Speech Interface built-in. Includes standard broadcast 

vocabulary plus ability to record custom phrases 

Automatic Functions On-board automatic functions with Jet™ Active Flowcharts, included. 

Email 10 email lists of up to 20 email addresses each 
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APPENDIX B: RSI VOCABULARY 

 

A  
ABOVE  
ACRODYNE  
ADJUST  
AEQ  
AIR  
AIR TOOLS  
ALARM  
ALARMS  
ALL  
ALTRONIC  
AM  
AMPS  
ANALOG  
ANTENNA  
ARE  
ARMSTRONG  
ARRAKIS  
ATLANTA  
AUDEMAT-AZTEC  
AUDIO  
AUDIO TECHNICA  
AUDIOLAB  
AURAL  
AUTO  
AUTOMATIC  
AUTOMATION  
AUXILIARY  
AVAILABLE  
AXCERA  
B  
BACKUP  
BAD  
BALTIMORE  
BASE  
BASE CURRENT  
BATTERY  
BE  
B E  
BEACON  
BEAM  
BELAR  
BELOW  
BETABRITE  
BEXT  
BIRD  
BOOT  
BOSE  
BOSTON  
BROADCAST TOOLS  
BUILDING  
BURK  
BURST  
C  
CARRIER  
CELSIUS  

CHANGE  
CHANNEL  
CHARLOTTE  
CHICAGO  
CHOOSE  
CLEAR  
CLEARED  
CLEVELAND  
CLOCK  
COAX  
COMBINER  
COMMAND  
COMPOSITE  
COMPUTER  
CONDITION  
CONDITIONING  
CONFIGURATION  
CONTACT  
CONTINENTAL  
CONTROL  
CONVERTER  
CRASH  
CRITICAL  
CROWN  
CURRENT  
D  
DALLAS  
DANAGGAR  
DAY  
DAYPART  
DAYTIME  
DEAD  
DECREASE  
DEGREE  
DEGREES  
DEICER  
DELAY  
DELTA  
DENON  
DENVER  
DETECTOR  
DETROIT  
DIAL  
DIELECTRIC  
DIGITAL  
DIGITAL AUDIO LABS  
DOLBY  
DOOR  
DOWN  
DOWNLINK  
DRIVE  
DTV  
DUMMY  
E  
EAS  
EAST  

EIGHT  
EIGHTEEN  
EIGHTY  
ELECTRIC  
ELEVEN  
EMERGENCY  
ENCO  
ENERGY-ONIX 
ENTER  
EQUALS  
EQUIPMENT  
ERI  
ERROR  
EVENTIDE  
EXCITER  
EXIT  
EXTERNAL  
EXTREME  
F  
FADE  
FAHRENHEIT  
FAIL  
FAN  
FAULT  
FIBER  
FIFTEEN  
FIFTY  
FILAMENT  
FINAL  
FIRE  
FIVE  
FLASHER  
FLOOR  
FLOW  
FM  
FM SCA  
FOR  
FORTY  
FORWARD  
FOURTEEN  
FREEZING  
FREQUENCY  
FRONT  
FUEL  
FURNACE  
G  
GAS  
GE  
GENERATOR  
GEPCO  
GOOD  
GOODBYE  
GORMAN REDLICH  
GPS  
GROUND  
H  

HARRIS  
HARTFORD  
HD  
HEATER  
HELLO  
HELP  
HERTZ  
HI  
HIGH  
HOLLYANNE  
HOT  
HOURS  
HOUSTON  
HUNDRED  
I  
IBOC  
IN  
INCREASE  
INDIANAPOLIS  
INOVONICS  
INPUT  
INTERFACE  
INTERLOCK  
INTRAPLEX  
INTRUSION  
IP  
IS  
ISN’T  
J  
JVC  
K  
KILO  
KILOVOLTS  
KILOWATTS  
KINTRONIC  
L  
LAN  
LANLINK  
LARCAN  
LEFT  
LEVEL  
LIGHT  
LIGHTWAVE  
LIMIT  
LINE  
LINK  
LINKS  
LOAD  
LOCAL  
LOGITEK  
LOOP  
LOS ANGELES  
LOW  
LOWER  
LUCID  
LYNX  
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M  
MACKIE  
MACRO  
MAGNET  
MAIN  
MANUAL  
MARTI  
MASTERCLOCK  
MEGA  
MEGAWATTS  
METER  
MIAMI  
MICRO  
MICROWAVE  
MIDDLE  
MILLI  
MILLIAMPS  
MILLIVOLTS  
MINNEAPOLIS  
MINOLTA  
MINUS  
MINUTES  
MIRANDA  
MODE  
MODULATION  
MODULE  
MONITOR  
MONO  
MOSELEY  
MOTOR  
MOTOROLA  
MULTIMEDIA  
MUTE  
MUTED  
N  
NASHVILLE  
NAUTEL  
NEC  
NETWORK  
NEUMANN  
NEW YORK  
NIGHT  
NINE  
NINETEEN  
NINETY  
NITROGEN  
NO  
NOISE  
NORMAL  
NORTH  
NOT  
NOW  
NTSC  
NUMBER  
O  
OFF  
OFF AIR  
OFFLINE  
OMNIA  
ON  
AIR  
ONE  

ONLINE  
ONLY  
OPEN  
ORBAN  
ORLANDO  
OUT  
OUTDOOR  
OUTPUT  
OVER  
OVERLOAD  
P  
PATTERN  
PEAK  
PELICAN  
PERCENT  
PHASE  
PHILADELPHIA  
PHOENIX  
PHONE  
PILOT  
PITTSBURGH  
PLATE  
PLEASE  
PORTLAND  
POSTSUNSET  
POTOMAC  
POUND  
POWER  
PRESET  
PRESSURE  
PRESUNRISE  
PRINTER  
PROCESSOR  
PROGRAM  
PUMP  
PUT  
Q  
QEI  
R  
RADIO  
RAISE  
RALEIGH  
RATIO  
RCA  
READY  
RECEIVER  
RECORD  
RECOVERY  
REFLECTED  
REJECT  
RELATIVE  
RELAY  
REMOTE  
REPEATER  
RESET  
RETURN  
REVERSE  
RF  
RHODE AND SCHWARTZ  
RIGHT  
ROLAND  
ROOM  

RPU  
RUN  
RUNNING  
S  
SACRAMENTO  
SAFE  
SAN DIEGO  
SAN FRANCISCO  
SATELLITE  
SBS  
SCREEN  
SEATTLE  
SECURITY  
SEE  
SENSOR  
SET  
SEVEN  
SEVENTEEN  
SEVENTY  
SHACK  
SHUT  
SHUTDOWN  
SIDE 
 SIDELIGHTS 
SIGHT  
SIGNAL  
SILENCE  
SITE  
SIX  
SIXTEEN  
SIXTY  
SMOKE  
SOUTH  
SPEED  
ST. LOUIS  
STACK  
STANDBY  
STAR  
STARLINK  
START  
STARTUP  
STATION  
STATUS  
STEREO  
STL  
STOP  
STOPPED  
STROBE  
STUDIO  
SUB  
SUBCARRIER  
SUPPLY  
SWITCH  
SYNC  
SYSTEM  
T  
T1  
TAMPA  
TAPE  
TELEMETRY  
TELOS  
TEMP  

TEMPERATURE  
TEN  
TERSE  
TEST  
TFT  
THALES  
THANK YOU  
THERMAL  
THIRTEEN  
THIRTY  
THIS  
THOUSAND  
THREE  
TIME  
TO  
TOO  
TOTAL  
TOWER  
TOWER LIGHTS  
TRANSFER  
TRANSLATOR  
TRANSMITTER  
TRIM  
TRL  
TSL  
TV  
TWELVE  
TWENTY  
TWO  
TWO-WAY  
U  
UNDER  
UNIT  
UP  
UPLINK  
UPS  
UTILITY  
V  
VERBOSE  
VIDEO  
VIRTUAL  
VISUAL  
VOICE  
VOLTS  
VSWR  
W  
WAIT  
WAN  
WARNING  
WASHINGTON  
WATER  
WATTS  
WEIGHT  
WEST  
WHY  
X  
Y  
YOU  
Z  
ZERO  
ZONE  
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